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Commanding Officer 
NOAA Ship:  Pisces 
 

PROJECT INSTRUCTIONS 
NOAA Ship Pisces PC-13-06 (29) 

 
I. Overview 
 

A. Project Period: October 10, 2013 to November 22, 2013 
 

B. Operating Area: Northern Gulf of Mexico between 80o00' and 97o00' W in depths of 30 to 
275 fm (Figure 1).  Approximate station locations will be provided to the Navigation 
Officer on a CD for importing into Nobeltec Visual Navigation Suite software. 

 
C. Summary of Objectives: 

1. Primary Objectives 
a. Sample the northern Gulf of Mexico with 90-ft high-opening fish trawl to determine 

the abundance and distribution of pelagic fish species. 
b. Collect length frequency data and biological samples of collected species. 
c. Conduct conductivity/temperature/depth (CTD) casts to profile temperature, salinity, 

conductivity, transmissivity, dissolved oxygen concentrations, and fluorometry. 
d. Collect ichthyoplankton samples with bongo and neuston samplers to map the 

distribution of fish eggs and larvae. 
e. Collect benthic infauna with a mini multicorer, Shipek grab and/or box grab at 

selected trawl stations. 
f. Collect acoustic data with EK60. 
g. Collect bathymetric data with ME70 during trawl stations. 
   

2. Secondary Objectives 
a. Conduct additional ichthyoplankton samples with bongo and neuston samplers. 
b. Conduct additional trawl sampling. 
c. Conduct additional CTD casts. 
d. Conduct bathymetric mapping. 

 
D. Participating Institutions: 

1. National Marine Fisheries Service (NMFS) – Pascagoula, MS Laboratory 
2. Troy University 
3. Middle Tennessee State University 
4. Auburn University 
5. University of Southern Mississippi - GCRL 
 

E. Personnel (Science Party) 
 
LEG 1 (October 10 – October 29, 2013) 
Name    Title             Sex    Organization      Citizenship 
Adam Pollack Field Party Chief M IAP, Miss. USA   
Paul Felts   Fishery Biologist M NMFS, Miss  USA 
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Kevin Rademacher  Fishery Biologist M NMFS, Miss  USA 
Kenny Wilkinson  ET   M NMFS, Miss  USA 
Alonzo Hamilton  Fishery Biologist M NMFS, Miss  USA 
Nick Hopkins   FMES   M NMFS, Miss  USA 
George Benz   Professor  M MTSU   USA 
Jeremy Timbs   Graduate Student M MTSU   USA 
Stephen Landers  Professor  M Troy   USA  
Craig Schimmer  Graduate Student M Troy   USA 
Ceil Martinec   Graduate Student F Troy   USA 
Alyssa Bennett  Graduate Student F Auburn  USA  
 
*Additional scientists may be added at a later date 
 
LEG 2 (November 3 – November 22, 2013) 
Name    Title             Sex    Organization      Citizenship  
Michael Hendon Field Party Chief M NMFS, Miss. USA 
Paul Felts Fishery Biologist M NMFS, Miss USA 
Kevin Rademacher Fishery Biologist M NMFS, Miss USA 
Michael Felts Fishery Biologist M IAP, Miss USA 
Keith Bates FMES M IAP, Miss USA 
Mark Grace Fishery Biologist M NMFS, Miss USA 
Jeremy Timbs Graduate Student M MTSU USA 
Nathan Barron Student M Troy USA 
Jonathan Miller Graduate Student M Troy USA 
   
 
*Additional scientists may be added at a later date 
 
 

F. Administrative: 
1. Points of Contact: 

a. Field Party Chief:  Michael Hendon; 3209 Frederic St., Pascagoula, MS 39567; (228) 
549-1643; Michael.Hendon@noaa.gov 

b. Field Party Chief:  Adam Pollack; 3209 Frederic St., Pascagoula, MS 39567; (228) 
549-1613; Adam.Pollack@noaa.gov 

c. Trawl Unit Leader: Gilmore “Butch” Pellegrin; 3209 Frederic St., Pascagoula, MS 
39567; (228)549-1688; Gilmore.Pellegrin@noaa.gov 

d. Operations Officer:  LT Kyle Byers, NOAA Ship Pisces, 151 Watts Ave, Pascagoula, 
MS 39567; (301) 713-7774; OPS.Pisces@noaa.gov 

 
2. Diplomatic Clearances: This cruise does not involve research under the jurisdiction of 

any other country. No diplomatic clearance has been requested. 
 

3. Licenses and Permits: 
This cruise will be conducted under the following permits although the majority of the 
sampling effort will be outside state territorial waters: 

a. Florida State Permit 
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b. Alabama State Permit 
c. Mississippi State Permit 
d. Louisiana State Permit 
e. Texas State Permit 
f. Southeast NMFS Regional Permit 
g. Sea Turtle Permit 

 
II.   Operations 

A.     Cruise Plan/Itinerary: 
 
Leg Date    Location   Days 
1  October 10, 2013  Depart Pascagoula, MS     

 October 29, 2013  Arrive Pascagoula, MS              20 
 
2  November 3, 2013  Depart Pascagoula, MS    

 November 22, 2013  Arrive Pascagoula, MS    20 
 
              40 

 
B. Staging and Destaging:   PASCAGOULA / PASCAGOULA 

 
C. Operations to be conducted: 

Operational Plans: 
Upon departure from Pascagoula on October 10, the lab will need to calibrate the EK60, 
weather permitting.  The ship will need to transit to an area with a least 60 m of water, 
with minimal wind.  The lab will need to send out additional scientists to assist with the 
calibration who are not part of the cruise personnel.  When calibration is complete, the 
ship will need to return to the sea buoy to offload the additional scientists onto a small 
boat from the lab.  If weather does not permit calibration at the start of leg 1, other 
attempts may be made at the end of 1 or start/end of leg 2.  After this is complete, the 
ship is requested to conduct scientific operations at preselected stations between 30 and 
275 fm from the south Texas coast to the south Florida coast (Figure 1).  The 40 day 
cruise will be conducted in 2 legs, requiring 24 hr operations with 2 scientific watches: 12 
am - 12 pm, 12 pm - 12 am.  The Field Party Chief (FPC) will provide work charts (NOS 
Coast Survey Chart numbers 11420-Havana to Tampa Bay, 11400-Tampa Bay to Cape 
San Blas, 11360-Cape St. George to Mississippi Passes, 11300-Galveston to Rio Grande, 
and 11340-Mississippi River to Galveston) with colored dots representing station 
locations.  Blue dots represent trawling stations and green dots represent ichthyoplankton 
stations.  Hang locations (derived from past surveys) will also be identified on charts with 
yellow dots to assist OODs in determining non-trawlable bottom.   
 
Operations at trawling stations will consist of CTD casts followed by trawling tows.  At 
selected trawling sites a bottom grab will be attempted. Operations at ichthyoplankton 
stations will consist of CTD casts followed by bongo and neuston tows.  At locations 
where trawl/ichthyoplankton samplings are combined, operations will consist of CTD 
casts, bongo tows, neuston tows then trawl tows.  The FPC or Watch Leader may alter 
the order of activities to facilitate catch processing.   The watch leader and/or FPC should 
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be notified if a station needs to be moved. 
 
Communication between the scientists and the bridge while on station will be 
accomplished via hand held radios. During rough weather, the watch leader with 
consultation from the ship’s crew will determine which sampling gear can be deployed 
safely. The FPC should be notified of any delays to sampling due to mechanical, medical, 
or weather issues as well.  

 
PRIMARY STATION OPERATIONS – At the Bridge’s 10 min warning, scientists and deck 
personnel will proceed to duty stations and prepare for station. Scientists and deck personnel 
should be ready and standing by for bridge’s call that the ship is on station and ready to 
proceed. Smoking is not permitted near or while handling any plankton nets due to the 
likelihood of burning holes in the nets. 

 
CTD profiles and environmental data collection  
After the CTD array is overboard, clear of all personnel and being lowered to just below 
the surface, the watch leader (lab scientist) will turn on the power to the unit and start the 
CTD recording. The unit must remain at the surface for 3 min to allow the unit to 
equilibrate to ambient temperature, after which time the unit is lowered to approximately 
2 m above the bottom or a max depth of 500 m.  After the cast, the CTD should be 
carefully set on deck, taking care not to jar the sensitive electronics. At least once a week, 
a water sample will be taken during a CTD cast.  During these casts, the CTD protocol 
will be as described with the exception that the CTD unit will be held at max depth for 1 
min, a water sample collected, and then retrieved.  The watch leader will clear the y-
connections periodically throughout the cruise. Additional environmental data collected 
during daylight hours are water color, Forel-Ule, percent cloud cover, and sea condition. 
The CTD will be in use 24 hours/day. Dissolved oxygen concentrations from sensors on 
the CTD will be verified using an Orion 3 Star Portable D.O. meter made by Thermo 
Scientific at the beginning of each leg and then every 5 days by the FPC.   

  
 Trawl Sampling 

 At proposed trawling sites, the ship is asked to survey the bottom along the path 
of the upcoming tow to check for obstructions that may damage the trawl. If the trawl 
path is determined to be clear of obstructions, the ship will proceed to conduct 1 tow with 
the 90-ft trawl. If the trawl path is determined to be untrawlable, then the ship is 
requested to move no more than 5 miles from the trawl location and survey again.  A 
maximum of 3 surveys will be conducted.  If after the third survey the trawl path is still 
untrawlable, then the station will be dropped and the ship will proceed to the next station.  
Each trawl will be towed for 30 min after the gear has sufficiently settled on the bottom 
as determined by the ITI net mensuration system, descent rate charts, and/or judgment of 
the Chief Boatswain.  The net will be towed at approximately 3 to 3.5 kt (speed over 
ground), and exact tow speed will be determined by the behavior of the gear (i.e., the 
head rope will need to be fished at 8 m from the bottom, and the foot rope will need to 
remain near the bottom).  Tow depth will be kept as close to constant as possible and 
depend upon the depth at the beginning of the tow.  At the end of the 30 min tow, the ship 
is requested to quickly increase speed to 5 kt for 2-5 min.  This pulse will help force fish 
in the body of the net into the cod end.  Upon completing a station, the ship will proceed 
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to the next sampling site.  The deck department is requested to shake down the net after 
each tow to remove all organisms.  For larger catches the deck department may be 
requested to weigh the catch with a crane scale.  If the net is damaged during the trawl 
but there are organisms, the deck crew is requested to remove all organisms before 
proceeding with net repair if net repair is at all possible.  In the case of the loss of a trawl 
net, the ship will attempt retrieval of net by towing a chain with a large grapple along the 
trawl track in the opposite direction of the initial tow. The amount of time dedicated to 
trawl retrieval will be decided by the FPC.  At any time that the trawl is not secure by the 
deck department, the scientific party will don personal protective equipment (PPE), 
which includes, but not limited to, work vest and hardhat.  In case of extreme mud in the 
net, the deck department, OOD, and watch leader will determine the best way to wash 
down the gear before the catch is emptied from the net.   
  
Grab Samples 
Grab sample operations will be conducted with a mini multicorer, Shipek Grab and/or 
box corer at designated trawling stations.  The grab will be deployed using an additional 
winch that will be provide by the lab and mounted with the CTD and bongo winch.  
The   winch is 3 conductor 220v AC (2 hots, no neutral and ground).  It will be deployed 
using the same A-frame as the bongo and CTD.  If there is not sufficient time to install 
the third winch, the bongo winch and cable with an open ocean rated SBE-19 CTD 
mounted 1-2 m above the grab will be used. The grab will be connected to the cable by a 
meter of stainless steel chain. The grab will be locked open prior to deployment.  When 
deploying, the deck should zero the wire readout when the SBE-19 is at the surface. The 
grab sampler will be monitored from the lab as it approaches maximum depth.  At 
approximately 15-20 m from the bottom, we will ask the desk department to stop the 
winch for 30 sec before running it into the bottom.  This will allow the pulse of water 
associated with the grab to settle down so as not to disturb the top layer of silt before 
impact.  As the grab encounters bottom, the chain slackens which causes the hook to 
release and allows the grab to close. Payout and retrieval rates should not exceed 40 
m/min.  If no sample is collected, the watch leader may or may not decide to do another 
attempt depending on time constraints. 

 
Bongo sampling 

The SEAMAP bongo plankton sampler is comprised of two 61 cm diameter 
collars with two 0.335 mm mesh nets. Prior to deployment of the bongo sampler, the 
watch leader must run software programs and prepare them for the bongo cast. The watch 
leader (lab scientist) will inform the deck when to power up the SBE-19 SEACAT, at 
which time the deck scientist will turn on the magnetic switch at the appropriate time. 
The bongo sampler is towed in an oblique path from near bottom, or 200 m max, to the 
surface. The SBE-19 SEACAT which is mounted above the bongo array on the sea cable 
will be used to monitor the tow path of the bongo net. Vessel speed should be adjusted 
during the bongo tow to maintain a 45 wire angle in order to uniformly sample 
throughout the water column. If angle exceeds 55, falls below 35 or if the combined 
variation exceeds 15, then the tow must be repeated (the samples will be saved until a 
better tow is completed). The net depth will be monitored by the watch leader. The deck 
scientist (or winch operator) will report wire angles periodically during downcast. On the 
watch leader’s command at max depth, the winch operator will stop payout of cable and 
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immediately start retrieval (do not allow net to settle). At that time, the wire angle and 
wire out should be reported to the watch leader from the deck. The watch leader will ask 
the winch operator to slowly retrieve the bongo array at 20 m per min for tow depths of 
100 m or deeper; for shallower stations the retrieval rate will be determined at each 
station based on station depth. The wire angle and remaining wire out should be reported 
from the deck to the watch leader regularly or as requested (on upcast or downcast).  

The deck personnel should report when the bongo array breaks the surface. Time 
will be recorded to the second (by the lab scientist) when the net breaks surface and 
flowmeters stop turning, at which time the winch operator immediately pulls the frame 
from the water; taking care not to let the bongo array continue to fish once it breaks the 
surface. When possible, the sample will be rinsed into the cod end of the net with a 
seawater hose while the net hangs over the side. In high winds, the scientist may request 
that the net is brought directly on board and rinsed down completely on deck. The bongo 
frame and net are finally placed on deck.  

Great care must be taken not to rest the frame on the nets, scrape the net with the 
frame against the deck, or walk on the plankton nets. The abrasions can easily cause 
holes in the nets requiring repair or replacement of these expensive sampling devices.  

If bottom sediment is present in both samples, the tow must be repeated. Any 
marginal sample will be saved until completion of the next tow. If bottom sediment (no 
more than 2 Tb) is present in only one sample the tow need not be repeated. Right bongo 
samples will be preserved in 95% Ethyl alcohol (ETOH) and transferred to new 95% 
ETOH after 24 h. Left bongo samples will be preserved in 10% formalin initially and 
transferred to 95% ETOH after 36 h. 

*Preservation methods subject to change. 
 

Neuston sampling 
The neuston net is a 1 x 2 m frame outfitted with a 0.947 mm mesh net. Each 

neuston tow will be conducted for 10 min at a vessel speed of approximately 2 kt to keep 
half the frame submerged in the water (i.e., maintain a sampling depth of 0.5 m). If 
necessary, the ship will steam forward in a wide arc to keep the neuston net (mouth 
opening) out of the influence of the prop wash. The duration of a neuston tow may be 
shortened to no less than 5 min when high concentrations of jellyfish, ctenophores, 
Sargassum, floating weed and/or debris are present in the water, or weather requires it. 
After retrieval, the sample is rinsed into the cod end with seawater while the net hangs 
over the side (if windy, deck scientist may request net to be brought directly on board and 
rinsed on deck). Neuston samples will be preserved in 95% ETOH initially and 
transferred to new 95% ETOH after 24 h. 

*Preservation methods subject to change. 
 
Acoustic Data  
 
Calibration 
 
I. Required Equipment  
 
 Simrad EK60 Splitbeam Echosounders operating at 

 18 kHz 
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 38 kHz 
 120 kHz 
 200 kHz 

 Transducer layout plan showing location of EK60 transducers relative to ship frame 
numbers 

 Calibration rigging equipment: 
 3 Outrigger poles, 18 feet long 
 3 Downrigger reels: Electric remote control reels on Pisces,  
 Downrigger control system: Electric remote control unit on Pisces,  
 3 Handheld VHF radios for use on deck 
 1 VHF radio (Handheld or Fixed) at echosounder workstation in acoustics lab 

 CTD to measure temperature and salinity to 50m depth prior to calibration 
 Calibration target (Supplied by MS Labs):  

 Material: Tungsten-carbide with 6% Cobalt binder 
 Surface Quality: Grade 25 
 Diameter: 38.1mm 

 Other equipment (supplied by MS Labs): 
 200 feet of lightweight nylon twine 
 1 lb weight or shackle 
 4 lb weight 
 Spectra fishing line to suspend target 
 Dishwashing liquid 

 
II. Ship Requirements 

 
 Perform CTD cast to provide temperature and salinity for upper 50m of water column 
 Ship will drift, without maneuvering, in water at least 60 m deep with wind initially on 

the port side. 
 Calibration will be conducted with Pisces centerboard in Retracted position. 
 Ship will periodically be required to make a slow turn to put wind on opposite side. 

This maneuver will probably be required once for each of four EK60 transducers. 
 Except for emergencies, maneuvering should only occur at scientists request and must 

be done very slowly to prevent fouling the suspended calibration gear. 
 Ship will refrain from discharging waste during calibration activities.  

III. Weather Requirements 
 

 Low (ideally zero) winds and calm (ideally flat) seas are necessary to make calibration 
successful 

 If the ship drifts at a speed through the water of 2 kt or more it is very difficult to 
control the location of the calibration target and perform a worthwhile calibration of 
the echosounder system 

 A survey desiring to calibrate the EK60 echosounder should be prepared to stop other 
survey operations and calibrate when a weather window of opportunity occurs 

 



 8

 
 

IV.  Procedures 
 
A. Preparation 

 Conduct CTD cast to obtain measurements of temperature and salinity for 
upper 50m of water column 

 Pisces centerboard to Retracted position 
 EK60 Software settings 
 Set transducer depths to zero 
 Set Ping Control to Interval and Rate to 1 sec 
 Set echogram range to 40m 
 Set data recording range to 60m 

B. Deploying Calibration Target 

 Calibration target must be kept clean and not dropped on deck or banged 
against hull during deployment. Scratches or other damage and oil or other 
contaminants on the surface of the sphere will alter its acoustic target strength. 
Prior to calibration, soak target sphere in a solution of 1-part dishwashing 
liquid and 4-parts water to discourage entrapment of bubbles on sphere 
surface when immersed in seawater for calibration. Otherwise calibration 
target should be kept in its protective case 

 Mount Outriggers 
 Rig snap swivels on ends of downrigger lines through pulleys on outriggers 
 Lower ends of downrigger lines to sea surface and set depth counters to zero; 

depth counters should not be reset again during calibration 
 Bring ends of the two downrigger lines on one side of ship up to a common 

point midway between the mounting locations 
 Pull the downrigger line from the other side of the ship under hull to attach to 

the two lines 
 Position 1 lb weight at midpoint of 200 ft nylon cord 
 Drop weight from bow of vessel and walk the ends of cord back the single 

outrigger position on one side and midpoint of outrigger locations on other 
side 

 Attach end of cord to single downrigger line and lower until counter indicates 
150 ft depth 

 Retrieve the cord from the other side and attach swivels of all three lines 
together 

 Attach monofilament loop on calibration target to spectra fishing line with 4 
lb weight attached at lower end and upper end attached to three downrigger 
lines.  

 Length of line between the target and the weight, and between the target and 
downrigger swivels must be at least two acoustic pulse lengths. 

 For 1 msec acoustic pulse lengths, 5 m spacing is recommended 
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 Lift the calibration target out of detergent solution using the line and without 
touching it lower it and the 4 lb weight into the water 

 Lower 4 lb weight and target until they are suspended from two outriggers 
 Simultaneously lower two outriggers so counters read 115’ 
 Return opposite downrigger from 140’ to 115’ 
 Adjust downriggers so that echoes from calibration target are observed near 

center of the beam of the first transducer to be calibrated, at approximately 25 
m depth 

C. Collect Calibration Data 

 Calculate the average temp and salinity for upper 30 m of water column, enter 
these values in EK60 Environment dialog window 

 Start recording of raw data 
 Calculate sphere target strength at each EK60 frequency using the specific 

depth, temperature, and salinity of the sphere location 
 Start and follow the Calibration procedure from the EK60 Operations Manual 

for the first transducer 
 Adjust position of target in transducer beam to collect at least 25 echoes in 

each quadrant of the beam 
 Echoes near the center of the beam are most important for estimating biomass 
 If the downriggers cannot be adjusted to put the target in windward portions 

of the transducer beam, the ship must be turned to make that the leeward side 
of the transducer beam 

 When enough target echoes have been collected with the first transducer, save 
the results and continue with the other transducers in the same fashion 

D. Recover Calibration Target 

 Lower the single outrigger on one side so that the calibration target can be 
retrieved 

 Rinse the calibration target in fresh water and store it safely  

E. Update Calibration Parameters 

 Return Pisces centerboard to lowered position 
 Post calibration data editing 
 Update calibration parameters in the Transceiver menu dialog 
 Set transducer depths back to proper values for lowered centerboard position 
 Reset EK60 software for survey data collection 
 Resume survey data collection 

Collection 
 
There are five main considerations for EK60 operation: (1) minimizing the impact on 
other scientific activities, (2) minimizing the interference from other instruments, (3) 
settings for data collection, (4) record keeping, and (5) data analysis. 
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1. The EK60 will operate continuously night and day.   The ST or ET on duty will 

be responsible for turning the EK60 on or off so that the bridge sounders may be 
operated as determined by the OOD. 

2. When the EK60 is running, it should be synchronized with the ES60, ADCP, and 
ME70 if operational. The EK60 display should be checked periodically for 
evidence of interference from other acoustic systems. 

 
Parameter settings that need to be checked: 

 Ping interval: 2 seconds for all depths. Set via the ‘interval’ data entry 
window at the top left of the EK60 Simrad data collection program. 

 The pulse width for 18 kHz, 38 kHz, 120 kHz and 200 kHz will be 1.0 ms. 
 Centerboard depth. Set via Operation->Normal->Depth: 6m for retracted, 

7.5m for intermediate, 9m for lowered. Never ping with the center board 
retracted. 

 Maximum sample range: 2000m. Set via the pull-down menu: Output-
>File->Raw Data->Range 

 Bottom Tracking Function: Disabled at 120, and 200 kHz (when doing so 
does not conflict with the needs of other users). 18 kHz: max set to 6000 
m; 38 kHz: max 2000 m. Set for each frequency by right-clicking on the 
bottom depth display found at the top of each channel’s window. 

 Make sure data recording is on! 
 

3. Each night, probably during a transect between trawl stations, try to collect 5 
minutes of data with all frequencies set to passive mode and the vessel 
maintaining survey speed. Set the mode under Operation->Normal to Passive for 
each frequency. Remember to set the modes back to Active afterwards. 
 

4. It is useful to keep track of all changes made to the operation of the EK60 in the 
SCS acoustic event log  

 
5. Output directory is set via Output->File->Directory. There will be a folder for the 

cruise on the portable Seagate hard-drive named F:/HB201303/EK60_Leg## (eg 
Leg01) 

 
6. Data recording is started by hitting the red arrow button. The display at the 

bottom of the window will then say ‘RECORD ON’ 
 

7. The Simrad ME 70 will be used at trawl sites.  The ME70 will be operated either 
by the ship’s ET or Survey Tech.  The sea bed will be mapped during two passes 
over the trawl site prior to setting the net, and during the trawl tow.  

 
 The ME70 will be synchronized with the EK60. 
 Charles Thompson will provide set up parameters for the ME70. 

 
Additional Mapping 
A secondary objective when the primary survey objective is unachievable due to weather, 
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etc. will be bathymetric mapping with the ME70 multibeam and EK60 echosounder.  
Mapping is to be at the discretion of the FPC; taking into consideration the amount of 
down-time from the primary mission and distances to and from potential mapping areas.  
A CTD cast or XBT needs to be conducted prior to conducting acoustic transects to 
obtain the speed of sound for proper processing of data.  All other acoustic systems need 
to be turned off prior to and during acoustic transects to eliminate acoustic contamination 
of the mapping data.  The FPC will determine the area to be mapped based upon location 
of the ship in relation to areas identified for mapping.  ME70 settings and configuration 
will follow protocols used during mapping on Reef Fish Surveys.  Transects for mapping 
will be composed in Hypack by the FPC and made available to the Ship’s Bridge crew. 
 

 Modifications to Field Operations 
Sampling protocol may be altered by the FPC or watch leader in order to optimize 
sampling for time conservation. The FPC may alter the project instructions in order to 
accomplish mission objectives but will do so only after consulting with the CO. If 
additional time becomes available during a leg, the FPC will provide the ship with further 
station locations at that time, after consulting with the CO. 

 
D. Dive Plan: N/A 

 
E. Applicable Restrictions: N/A 

 
III.   Equipment 

A.   Equipment and Capabilities Provided by the Ship: 
1. SCS version 451.1063 
2. Net reel - for spooling the 90 foot HBOT 
3. Simrad ITI Net Mensuration System or the FS-70 Turtle 
4. Because of the importance of the CTD equipment package to record environmental data 

and the need for the Scientific Computing System (SCS), an Electronics Technician is 
imperative. 

5. Trawl winches with sufficient wire to fish in 275 fm depths and meter readouts to 
determine warp length  

6. Hydrographic winch with wire and meter readout to accomplish CTD/bottle casts and 
bongo tows up to a 200 m depth. Winch speed should be variable to include 50 m/min 
during pay-out and 20 m/min during haul back (for bongo tows). Spare slip rings for 
each winch. Fully functional wire readouts for each winch. 

7. Winch, crane, and wire for deploying neuston net. 
8. Three (3) touch screen monitors for the FSCS. 
9. One (1) Primary SBE 9plus CTD configured as follows; 

a. Unit should be mounted horizontally and mounted in the water sampling frame. The 
frame should be examined to ensure it is in good physical condition and there are no 
breaks present in any of the welds supporting the frame. 

b. The standard 12 position SBE 32 Carousel should be properly mounted in the water 
sampler section of the frame and tested to ensure that all 12 bottle positions are 
working properly and respond to software requests for firing. 

c. The internal Digiquartz pressure sensor should be in good working order and have a 
calibration/service date not to exceed 365 days. 
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d. The primary sensor suite should be installed and consist of the following (the sensors 
should have a calibration date as recent as possible, not to exceed 365 days): 

i. One (1) SBE 3 Premium Temperature sensor 
ii. One (1) SBE 4 Conductivity sensor 
iii. One (1) SBE 43 Dissolved Oxygen sensor 
iv. One (1) “Y” air bleeder valve. Valve should be checked to ensure it is not clogged. 
v. One (1) Wetlabs Wetstar pumped fluorometer 
vi. One (1) SBE 5T pump that has been checked by Seabird within the last 365 days 

for proper operation 
vii. One (1) Wetlabs C-Star transmissometer 
viii. Proper plumbing. Tubing should be checked to ensure it meets Seabird’s 

recommended method of plumbing and is free from cracks and holes. With red end 
caps for proper storage between stations. 

e. The secondary sensor suite should be installed and consist of the following (the sensors 
should have a calibration date as recent as possible, not to exceed 365 days): 
i. One (1) SBE 3 Premium Temperature sensor 
ii. One (1) SBE 4 Conductivity sensor 
iii. One (1) SBE 43 Dissolved Oxygen sensor 
iv. One (1) “Y” air bleeder valve. Valve should be checked to ensure it is not clogged 
v. One (1) Wetlabs Wetstar pumped fluorometer 
vi. One (1) SBE 5T pump that has been checked by Seabird within the last 365 days 

for proper operation 
vii. One (1) Wetlabs C-Star transmissometer 
viii. Proper plumbing. Tubing should be checked to ensure it meets Seabird’s 

recommended method of plumbing and is free from cracks and holes. 
f. The unit should be properly terminated and connected to a properly functioning SBE 

11 Deck Unit. The deck unit should be connected to allow the following: 
i. Proper control of the SBE Water Sampler Carousel via the SEASAVE application 
ii. Integration of a proper NMEA signal from a GPS unit. 

6. A second SBE 9plus profiler should be available as well. Unit does not have to be 
configured as a complete functioning ready-to-install on the sea cable unit; however, it 
should have the following components available: 

a. Sensors for a Primary suite (with a calibration date as recent as possible, not to exceed 
365 days): 
i. One (1) SBE 3 Premium Temperature sensor 
ii. One (1) SBE 4 Conductivity sensor 
iii. One (1) SBE 43 Dissolved Oxygen sensor 
iv. One (1) “Y” air bleeder valve. Valve should be checked to ensure it is not clogged. 
v. One (1) Wetlabs Wetstar pumped fluorometer 
vi. One (1) SBE 5T pump that has been checked by Seabird within the last 365 days 

for proper operation. 
vii. One (1) Wetlabs C-Star transmissometer 
viii. Proper plumbing. Tubing should be checked to ensure it meets Seabird’s 

recommended method of plumbing and is free from cracks and holes. 
b. Sensors for a complete Secondary suite (with a calibration date as recent as possible, 

not to exceed 365 days): 
i. One (1) SBE 3 Premium Temperature sensor 
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ii. One (1) SBE 4 Conductivity sensor 
iii. One (1) SBE 43 Dissolved Oxygen sensor 
iv. One (1) “Y” air bleeder valve. Valve should be checked to ensure it is not clogged. 
v. One (1) Wetlabs Wetstar pumped fluorometer 
vi. One (1) SBE 5T pump that has been checked by Seabird within the last 365 days 

for proper operation. 
vii. One (1) Wetlabs C-Star transmissometer. 
viii. Proper plumbing. Tubing should be checked to ensure it meets Seabird’s 

recommended method of plumbing and is free from cracks and holes. 
7. A second SBE 11 Deck Unit should be on the ship to be put into service if needed. 
8. Two (2) fully operational SBE 19 Seacat profilers should be available. One of the units 

should be installed on the sea cable. Both units should have calibration dates not to exceed 
365 days. 

9. Two (2) functional SBE 36 Deck units should be available, 1 for backup, which are 
configured for the model Seacat being supplied. 

10. Two (2) PDIM units should be available for use with the SBE 19 units. One of these 
PDIM units should be installed on the primary SBE19 on the sea cable. These PDIM units 
should also be the proper units that are used with the model Seacat being used. 

11. A fully functional SBE 21 thermosalinograph should be available for the survey. The unit 
should have calibrations that do not exceed 365 days. The calibration data must be 
verified/entered into the SEABIRD-TSB.CAL file in the Ship Directory of SCS. 

12. It is highly desirable to have the following additional spare sensors on-board if possible: 
a. One (1) SBE 43 DO Sensor 
b. One (1) SBE 3 Temperature Sensor 
c. One (1) SBE 4 Conductivity Sensor 
d. One (1) Wetlabs Wetstar pumped fluorometer 
e. One (1) Wetlabs C-Star Transmissometer 
f. One (1) SBE 5T Pump 

14. Copies of all calibration sheets for CTD profilers, TSG, and spare sensors should be 
provided to the laboratories’ Shipboard System Specialist prior to sailing. 

15. CTD capable winch and A-frame for CTD casts, with sufficient electromechanical cable 
for casts to 500 m. 

16. NMEA GPS input to CTD header file. 
17. Inside and outside conveyor belts for processing catches. 
18. Freezer space for preserving scientific specimens. 

SCS data requested: The SCS system should be fully operational for the duration of the 
survey. Due to the nature of the survey work, we request that all the events (CTD, Bongo, 
Neuston, Bottom Grabs, and trawls) be conducted from the dry lab.  A listing of any sensors 
that will not be functional for the survey should be provided prior to sailing to the FPC, taking 
into consideration that event templates will have to be checked by the Shipboard System 
Specialists to ensure there will be no impact or an alternative sensor can be selected. 

a. SIMRAD - primary 
i. UTC time 
ii. Latitude 
iii. Longitude 
iv. Speed over ground 
v. Course over ground 
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b. SIMRAD - secondary 
i. Latitude 
ii. Longitude 
iii. Speed over ground 
iv. Course over ground 

c. Furuno doppler speed log 
i. Speed through the water 
ii. Speed over ground 

c. EK60 depth in meters 
d. Gyro-heading 
e. Air temperature (°C) 
f. Barometric pressure 
g. True wind speed 
h. True wind direction 
i. Information should be passed to the Rotating ET to ensure the following: 

i. The Automatic Logger Control on the SCS Server must be enabled anytime ACQ is 
started and should use the default of 0:00:00 (Midnight GMT). 

ii. The contents of the Eventdata folder should be allowed to remain present for the 
duration of the survey (they should not be deleted between legs). This will ensure 
that event IDs do not restart for the respective events during the survey. 

j. SEASAVE SOFTWARE: Prior to sailing, the proper .CON files should be built in 
SEASAVE. The software should be set to look for the proper .CON file for the 
respective instrument. 

k. It is also highly desirable that the ASCII Out function be allowed to feed CTD data 
into SCS via serial cable. 

20. DRYLAB REMOTE COMPUTERS - Due to the nature of the work involved with data 
collection for this survey, it is recommended that all three (3) FSCS Remote units be 
verified for the following prior to sailing: 

a. All 3 computers are 100% operational 
b. All 3 computers are properly setup to interface as SCS clients 
c. Two (2) of the units have a functioning copy of Microsoft Office XP Professional.  The 

Office suite must provide at minimum the following programs: Word, Excel, 
PowerPoint and Access. 

d. All 3 computers must be able to print to a functioning printer. 
 

B. Equipment and Capabilities Provided by the Scientists: 
1. 90-ft HOBT survey trawls (4); and bridles and rigging (3 sets) 
2. Winch for deploying bottom grabs 
3. 3.5m steel doors (2 sets) 
4. Trawl hardware box 
5. Spare webbing and net repair materials 
6. Three electronic fish measuring boards 
7. Five hundred plastic specimen bags 
8. Five Marel 1100 electronic weighing scales 

i. Two 30-kg capacity 
ii. Three 6-kg capacity 

9. Field data sheets 



 15

10. Crane scale 
11. Fish baskets, shovels, sorting rakes and trays 
12. Mini Multicorer (1) 
13. Shipek bottom grab (1) 
14. Box corer (1) 
15. Two 61-cm bongo frames 
16. Two 12 m neuston frames 
17. Bongo/neuston gear and equipment box 
18. Plankton sampling supplies box 
19. Plankton preserving jars and lids 
20. Chemical transfer pumps 
21. 6 Niskin bottles 
22. Safety goggles 
23. Latex and Nitrile puncture resistant work gloves 
24. Grapple and chain for retrieving lost trawl 
25. Handheld Orion 3 star meter and equipment box 
26. 5 ICOM VHF Marine handheld radios (IC-M72) 
27. Various clerical supplies 
28. Computer for FPC stateroom 
29.  Spent chemical collection Drum 
30. Dissecting Microscopes 2  
31. Plankton Table 
32. Fish and Invertebrate Identification Reference Materials 
33. Vermiculite or kitty litter (chemical absorbent) 

 
 

IV. Hazardous Materials 
A. Policy and Compliance: 

The FPC shall be responsible for complying with MOCDOC 15, Fleet Environmental 
Compliance #07, Hazardous Material and Hazardous Waste Management Requirements for 
Visiting Scientists, released July 2002. Documentation regarding those requirements will be 
provided by the Chief of Operations, Marine Operations Center, upon request. 

By Federal regulations and NOAA Marine and Aviation Operations policy, the ship may 
not sail without a complete inventory of all hazardous materials by name and the anticipated 
quantity brought aboard, MSDS and appropriate neutralizing agents, buffers, and/or 
absorbents in amounts adequate to address spills of a size equal to the amount of chemicals 
brought aboard. The amount of hazardous material arriving and leaving the vessel shall be 
accounted for by the FPC. 

 
B. Radioactive Isotopes: N/A 

 
C. Inventory: Expected hazardous materials to be brought on board for this cruise are: 
1. Ethanol (190 proof, 95% pure) – 110 gal 
2. Formalin (37%) – 15 gal 
3. Triton ® X-100, 10% solution - 2 gal 
4. Deionized Water - 15 L 
5. 10% Buffered Formalin - 4 gal 
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*Additional chemicals may be brought on board and will be in the full hazmat inventory before departure. 
 

V. Additional Projects 
A. Supplementary (“Piggyback”) Projects: N/A 
B. NOAA Fleet Ancillary Projects: N/A 

 
VI. Disposition of Data and Reports 

A. Data Responsibilities: 
The ship’s ET Department is requested to provide the FPC with copies of SCS folders, 
“EventData” and “SCS_Datalog”, as well as the raw data files associated with both the SBE 9-11 
profiler and SBE-19 SEACAT at the end of each survey leg (on CD or DVD).  The ET 
Department is also asked to collect and archive the SCS Datalog in the following manner: 

1. The contents of the Primary SCS EventData folder should be emptied prior to the 
start of the survey and should not be erased between legs of the survey. All other 
Datalog folders should be emptied in accordance to the guideline specified in the SCS 
Documentation. That is, at the start of a survey all data files should be deleted from 
the Datalog and from its sub-folders prior to the survey with the exception of the 
Coastline sub-folder. The contents of the Coastline folder and the folder itself should 
never be deleted.  All other sub-folders in the Datalog may have their contents 
deleted. If the EventData sub-folder contains sub-folders for each event that was 
previously run, these folders should be deleted along with their data files as the Event 
Logger will recreate the folders for the respective events the first time they are run. 

2. The Automatic Logger Control on the Logger Control form of SCS should be set to 
Enable Logging for Auto Start/Stop each time acquisition (ACQ) is started. The 
time value should be set to the default of 0 Hours, 0 Minutes, 0 Seconds GMT. 

3. The raw data files, *.RAW in the Datalog folder may be deleted between legs if 
space for logging is needed provided the data have been backed up to CD and the CD 
verified prior to deletion. 

4. The entire Datalog should be backed up to the Backup SCS server for the duration of 
the cruise at a frequency of at least once per hour. Prior to sailing, this Datalog 
should be reset in accordance to the directions as specified above, and as is done on 
the Primary SCS ACQ computer. 

5. Prior to sailing, the current SCS software on the primary SCS server will be mirrored 
on the backup SCS server.  Thus, the same version of the executables for SCS along 
with all templates, events, real-time displays, gauges, and sensor.scf configuration 
files should be present on the Backup SCS server in the event of a Primary SCS 
system failure.   

6. Prior to sailing, the lab’s Shipboard Systems Specialist will be provided with copies 
of all calibration data for each sensor installed on the ship associated with the primary 
and secondary SBE 9-11 profiler and SBE19 SEACAT. This information is useful to 
track problems in the .CON files should they arise. 

 
The FPC is responsible for submission of a ROSCOP II form (NOAA, Form 2423) to the 
National Oceanographic Data Center within 30 days after cruise termination. 

 
B. Cruise Meetings: 
Welcome aboard Meeting: On the ship prior to departure, the FPC will conduct a meeting of 



 17

the scientific party to train them in sample collection and inform them of cruise objectives. 
Some vessel protocols, e.g., meals, etiquette, etc. will be presented by the ship’s Operations 
Officer. 

 
Post-Cruise Meeting: If need be, upon completion of the cruise, a post-cruise meeting will be 
held and attended by the ship’s officers, the FPC and members of the scientific party, the 
Vessel Coordinator, and the Port Captain to review the cruise. Concerns regarding safety, 
efficiency and suggestions for improvement for future cruises should be discussed. Minutes of 
the post-cruise meeting will be taken by the Pascagoula Port Captain and distributed to all 
participants with e-mail to the CO.MOC.Atlantic@noaa.gov and ChiefOps.MOA@noaa.gov . 
A cruise report will be prepared by the FPC and submitted to the Director, SEFSC, within 30 
days after the cruise is completed. 

 
C. Ship Operation Evaluation Report: 

Within 7 days of the completion of the cruise, a Ship Operation Evaluation form is to be 
completed by the FPC. The preferred method of transmittal of this form is via email to 
OMAO.Customer.Satisfaction@noaa.gov . If email is not an option, a hard copy may be 
forwarded to: 

 
 Director, NOAA Marine and Aviation Operations 
 NOAA Office of Marine and Aviation Operations 
 8403 Colesville Road, Suite 500 
 Silver Spring, MD 20910 
 

A file copy of each completed evaluation form will be sent to the SEFSC Mississippi 
Laboratory Director and the SEFSC Vessel Coordinator. 

 
VII. Miscellaneous 

A. Meals and Berthing: 
Meals and berthing are required for up to 15 scientists per leg. Meals will be served 3 

times daily. Since the watch schedule is split between day and night, the night watch may 
often miss daytime meals and will require adequate food and beverages (for example a variety 
of sandwich items, cheeses, fruit, milk, juices) during what are not typically meal hours. 
Special dietary requirements for scientific participants will be made available to the ship’s 
command at least 7 days prior to the survey. 

Berthing requirements, including number and gender of the scientific party, will be 
provided to the ship by the FPC. The FPC and the Operations Officer will work together on a 
detailed berthing plan to accommodate the gender mix of the scientific party taking into 
consideration the current make-up of the ship’s complement. The FPC is responsible for 
ensuring the scientific berthing spaces are left in the condition in which they were received; 
for stripping bedding and linen return; and for the return of any room keys which were issued. 
The FPC is also responsible for the cleanliness of the laboratory spaces and the storage areas 
utilized by the scientific party, both during the cruise and at its conclusion prior to departing 
the ship. 

All NOAA scientists will have proper travel orders when assigned to any NOAA ship. The 
FPC will ensure that all non NOAA or non Federal scientists aboard also have proper orders. 
It is the responsibility of the FPC to ensure that the entire scientific party has a mechanism in 
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place to provide lodging and food and to be reimbursed for these costs in the event that the 
ship becomes uninhabitable and/or the galley is closed during any part of the scheduled 
project. 

All persons boarding NOAA vessels give implied consent to comply with all safety and 
security policies and regulations which are administered by the CO. All spaces and equipment 
on the vessel are subject to inspection or search at any time. All personnel must comply with 
OMAO's Drug and Alcohol Policy dated May 7, 1999 which forbids the possession and/or 
use of illegal drugs and alcohol aboard NOAA Vessels. 

 
B. Medical Forms and Emergency Contacts: 

The NOAA Health Services Questionnaire (NHSQ, Revised: 12/11) must be completed in 
advance by each participating scientist. The NHSQ can be obtained from the FPC or the 
NOAA website at http://www.corporateservices.noaa.gov/~noaaforms/eforms/nf57-10-01.pdf   
The completed form should be sent to the Regional Director of Health Services at Marine 
Operations Center. The participant can mail, fax, or scan the form into an email using the 
contact information below. The NHSQ should reach the Health Services Office no later than 4 
weeks prior to the cruise to allow time for the participant to obtain and submit additional 
information that health services might require before clearance to sail can be granted. Please 
contact MOC Health Services with any questions regarding eligibility or completion of the 
NHSQ. Be sure to include proof of tuberculosis (TB) testing, sign and date the form, and 
indicate the ship or ships the participant will be sailing on. The participant will receive an 
email notice when medically cleared to sail if a legible email address is provided on the 
NHSQ.  

  
Contact information:  

 Regional Director of Health Services  
 Marine Operations Center – Atlantic  
 439 W. York Street  
 Norfolk, VA 23510 
 Telephone 757.441.6320 
 Fax 757.441.3760 
 E-mail MOA.Health.Services@noaa.gov  
 
 Prior to departure, the FPC must provide a listing of emergency contacts to the Executive 
Officer for all members of the scientific party, with the following information: name, address, 
relationship to member, and telephone number. 
 

C. Shipboard Safety: 
Wearing open-toed footwear or shoes that do not completely enclose the foot (such as 

sandals or clogs) outside of private berthing areas is not permitted. Hard hats are required 
when working with suspended loads. Work vests are required when working near open 
railings and during small boat launch and recovery operations. Hard hats and work vests will 
be provided by the ship when required.  

 
D. Communications: 

A progress report on operations prepared by the FPC may be relayed to the program office. 
Sometimes it is necessary for the FPC to communicate with another vessel, aircraft, or shore 
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facility. Through various means of communications, the ship can usually accommodate the 
FPC. Special radio voice communications requirements should be listed in the project 
instructions. The ship’s primary means of communication with the Marine Operations Center 
is via e-mail and the Very Small Aperture Terminal (VSAT) link. Standard VSAT bandwidth 
at 128kbs is shared by all vessels staff and the science team at no charge. Increased bandwidth 
in 30 day increments is available on the VSAT systems at increased cost to the scientific 
party. If increased bandwidth is being considered, program accounting is required it must be 
arranged at least 30 days in advance. Communication between the bridge, the dry lab, and the 
deck during plankton operations will be by VHS radio. We request 30 min and 10 min 
notification prior to arriving at stations. 

 
E. IT Security: 

Any computer that will be hooked into the ship's network must comply with the OMAO 
Fleet IT Security Policy prior to establishing a direct connection to the NOAA WAN. 
Requirements include, but are not limited to: 

 
1. Installation of the latest virus definition (.DAT) file on all systems and performance of a 

virus scan on each system. 
2. Installation of the latest critical operating system security patches. 
3. No external public Internet Service Provider (ISP) connections. 

 
Completion of these requirements prior to boarding the ship is required. Non-NOAA 

personnel using the ship's computers or connecting their own computers to the ships network 
must complete NOAA’s IT Security Awareness Course within 3 days of embarking. 

 
F. Foreign National Guests Access to OMAO Facilities and Platforms: N/A 



 20

Leg I

Leg II
Leg III

 24

 25

 26

 27

 28

 29

 30

 31

 32

98 97 96 95 94 93 92 91 90 89 88 87 86 85 84 83 82 81 80

Leg I

Leg II

 24

 25

 26

 27

 28

 29

 30

 31

 32

98 97 96 95 94 93 92 91 90 89 88 87 86 85 84 83 82 81 80

 Figure 1. Operational area for NOAA Ship Pisces PC-13-06 (29). 
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